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Thank you for purchasing the RFC2544 Test Application for AE5511, a software option 
for the AE5511 TrafficTesterPro. 
This User’s Manual contains useful information about the functions and operations of 
the software.  To ensure correct use, please read this manual thoroughly before 
beginning operation.  After reading the manual, keep it in a convenient location for 
quick reference whenever a question arises during operation. 
For the operation and handling of the AE5511 TrafficTesterPro, see the respective 
manuals for the AE5511. 
• AE5511 TrafficTesterPro User’s Manual (IM417322900-01E) 
• AE5511 TrafficTesterPro Startup Manual (IM417322900-02E) 
• AE5511 TrafficTesterPro Remote Command Manual (IM417322900-17E) 

Notes 
• The contents of this manual are subject to change without prior notice as a result of 

continuing improvements to the instrument’s performance and functions.  The figures 
given in this manual may differ from those that actually appear on your screen. 

• Every effort has been made in the preparation of this manual to ensure the accuracy 
of its contents.  However, should you have any questions or find any errors, please 
contact your nearest YOKOGAWA dealer. 

• The contents of this manual may not be transcribed or reproduced, in part or in their 
entirety, without prior permission. 

Trademarks 
• Windows, Hyper Terminal, and .NET Framework are either registered trademarks or 

trademarks of Microsoft Corporation in the United States and/or other countries. 
• Adobe, Acrobat, and Acrobat Reader are trademarks or registered trademarks of 

Adobe Systems Incorporated. 
• For purposes of this manual, the TM and ® symbols do not accompany their 

respective trademark names or registered trademark names. 
• Other company and product names are trademarks or registered trademarks of their 

respective holders. 
Revisions 

• 1st Edition: June, 2006 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1st Edition : June 2006 (YK) 

All Rights Reserved, Copyright © 2006 Yokogawa Electric Corporation 
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Terms and Conditions of the Software License 
 
Yokogawa Electric Corporation, a Japanese corporation (hereinafter called “Yokogawa”), grants permission to use this Yokogawa Software Program 
(hereinafter called the “Licensed Software”) to the Licensee  on the conditions that the Licensee agrees to the terms and conditions stipulated in 
Article 1 hereof.  
You, as the Licensee (hereinafter called “Licensee”), shall agree to the following terms and conditions for the software license (hereinafter called the 
“Agreement”) based on the use intended for the Licensed Software.   
Please note that Yokogawa grants the Licensee permission to use the Licensed Software under the terms and conditions herein and in no event shall 
Yokogawa intend to sell or transfer the Licensed Software to the Licensee. 
 
Licensed Software Name: RFC2544 Test Application for AE5511 
Number of License: Installation of the RFC2544 Option to the AE5511: 1 (This option can be installed to a single AE5511.) 
 RFC2544 Test Application installation to PCs: Multiple PCs allowed 
 
Article 1 (Scope Covered by these Terms and Conditions) 
1.1 The terms and conditions stipulated herein shall be applied to any Licensee who purchases the Licensed Software on the condition that the 

Licensee consents to agree to the terms and conditions stipulated herein. 
1.2 The “Licensed Software” herein shall mean and include all applicable programs and documentation, without limitation, all proprietary technology, 

algorithms, and know-how such as a factor, invariant or process contained therein. 
 
Article 2 (Grant of License) 
2.1 Yokogawa grants the Licensee, for the purpose of single use, non-exclusive and non-transferable license of the Licensed Software with the 

license fee separately agreed upon by both parties.   
2.2 The Licensee is, unless otherwise agreed in writing by Yokogawa, not entitled to copy, change, sell, distribute, transfer, or sublicense the 

Licensed Software. 
2.3 The Licensed Software shall not be copied in whole or in part except for keeping one (1) copy for back-up purposes.  The Licensee shall secure 

or supervise the copy of the Licensed Software by the Licensee itself with great, strict, and due care.  
2.4 In no event shall the Licensee dump, reverse assemble, reverse compile, or reverse engineer the Licensed Software so that the Licensee may 

translate the Licensed Software into other programs or change it into a man-readable form from the source code of the Licensed Software.  
Unless otherwise separately agreed by Yokogawa, Yokogawa shall not provide the Licensee the source code for the Licensed Software.  

2.5 The Licensed Software and its related documentation shall be the proprietary property or trade secret of Yokogawa or a third party which grants 
Yokogawa the rights.  In no event shall the Licensee be transferred, leased, sublicensed, or assigned any rights relating to the Licensed 
Software. 

2.6 Yokogawa may use or add copy protection in or onto the Licensed Software.  In no event shall the Licensee remove or attempt to remove such 
copy protection. 

2.7 The Licensed Software may include a software program licensed for re-use by a third party (hereinafter called “Third Party Software”, which may 
include any software program from affiliates of Yokogawa made or coded by themselves.)  In the case that Yokogawa is granted permission to 
sublicense to third parties by any licensors (sub-licensor) of the Third Party Software pursuant to different terms and conditions than those 
stipulated in this Agreement, the Licensee shall observe such terms and conditions of which Yokogawa notifies the Licensee in writing separately. 

2.8 In no event shall the Licensee modify, remove or delete a copyright notice of Yokogawa and its licenser contained in the Licensed Software, 
including any copy thereof. 

 
Article 3 (Restriction of Specific Use) 
3.1 The Licensed Software shall not be intended specifically to be designed, developed, constructed, manufactured, distributed or maintained for the 

purpose of the following events: 
a) Operation of any aviation, vessel, or support of those operations from the ground;, 
b) Operation of nuclear products and/or facilities;, 
c) Operation of nuclear weapons and/or chemical weapons and/or biological weapons; or 
d) Operation of medical instrumentation directly utilized for humankind or the human body. 

3.2 Even if the Licensee uses the Licensed Software for the purposes in the preceding Paragraph 3.1, Yokogawa has no liability to or responsibility 
for any demand or damage arising out of the use or operations of the Licensed Software, and the Licensee agrees, on its own responsibility, to 
solve and settle the claims and damages and to defend, indemnify or hold Yokogawa totally harmless, from or against any liabilities, losses, 
damages and expenses (including fees for recalling the Products and reasonable attorney’s fees and court costs), or claims arising out of and 
related to the above-said claims and damages. 

 
Article 4 (Warranty) 
4.1 The Licensee shall agree that the Licensed Software shall be provided to the Licensee on an “as is” basis when delivered.  If defect(s), such as 

damage to the medium of the Licensed Software, attributable to Yokogawa is found, Yokogawa agrees to replace, free of charge, any Licensed 
Software on condition that the defective Licensed Software shall be returned to Yokogawa’s specified authorized service facility within seven (7) 
days after opening the Package at the Licensee’s expense.  As the Licensed Software is provided to the Licensee on an “as is” basis when 
delivered, in no event shall Yokogawa warrant that any information on or in the Licensed Software, including without limitation, data on computer 
programs and program listings, be completely accurate, correct, reliable, or the most updated.  

4.2 Notwithstanding the preceding Paragraph 4.1, when third party software is included in the Licensed Software, the warranty period and terms and 
conditions that apply shall be those established by the provider of the third party software.  

4.3 When Yokogawa decides in its own judgement that it is necessary, Yokogawa may from time to time provide the Licensee with Revision 
upgrades and Version upgrades separately specified by Yokogawa (hereinafter called “Updates”). 

4.4 Notwithstanding the preceding Paragraph 4.3, in no event shall Yokogawa provide Updates where the Licensee or any third party conducted 
renovation or improvement of the Licensed Software. 

4.5 THE FOREGOING WARRANTIES ARE EXCLUSIVE AND IN LIEU OF ALL OTHER WARRANTIES OF QUALITY AND PERFORMANCE, 
WRITTEN, ORAL, OR IMPLIED, AND ALL OTHER WARRANTIES INCLUDING ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR 
FITNESS FOR A PARTICULAR PURPOSE ARE HEREBY DISCLAIMED BY YOKOGAWA AND ALL THIRD PARTIES LICENSING THIRD 
PARTY SOFTWARE TO YOKOGAWA. 

4.6 Correction of nonconformity in the manner and for the period of time provided above shall be the Licensee’s sole and exclusive remedy for any 
failure of Yokogawa to comply with its obligations and shall constitute fulfillment of all liabilities of Yokogawa and any third party licensing the 
Third Party Software to Yokogawa (including any liability for direct, indirect, special, incidental or consequential damages) whether in warranty, 
contract, tort (including negligence but excluding willful conduct or gross negligence by Yokogawa) or otherwise with respect to or arising out of 
the use of the Licensed Software. 

 
Article 5 (Infringement) 
5.1 If and when any third party should demand injunction, initiate a law suit, or demand compensation for damages against the Licensee under 

patent right (including utility model right, design patent, and trade mark), copy right, and any other rights relating to any of the Licensed Software, 
the Licensee shall notify Yokogawa in writing to that effect without delay. 
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5.2 In the case of the preceding Paragraph 5.1, the Licensee shall assign to Yokogawa all of the rights to defend the Licensee and to negotiate with 

the claiming party.  Furthermore, the Licensee shall provide Yokogawa with necessary information or any other assistance for Yokogawa’s 
defense and negotiation.  If and when such a claim should be attributable to Yokogawa, subject to the written notice to Yokogawa stated in the 
preceding Paragraph 5.1, Yokogawa shall defend the Licensee and negotiate with the claiming party at Yokogawa’s cost and expense and be 
responsible for the final settlement or judgment granted to the claiming party in the preceding Paragraph 5.1. 

5.3 When any assertion or allegation of the infringement of the third party’s rights defined in Paragraph 5.1 is made, or when at Yokogawa’s 
judgment there is possibility of such assertion or allegation, Yokogawa will, at its own discretion, take any of the following countermeasures at 
Yokogawa’s cost and expense. 

a) To acquire the necessary right from a third party which has lawful ownership of the right so that the Licensee will be able to continue to use the 
Licensed Software; 

b) To replace the Licensed Software with an alternative one which avoids the infringement; or 
c) To remodel the Licensed Software so that the Licensed Software can avoid the infringement of such third party’s right. 
5.4 If and when Yokogawa fails to take either of the countermeasures as set forth in the preceding subparagraphs of Paragraph 5.3, Yokogawa shall 

indemnify the Licensee only by paying back the price amount of the Licensed Software which Yokogawa has received from the Licensee.  THE 
FOREGOING PARAGRAPHS STATE THE ENTIRE LIABILITY OF YOKOGAWA AND ANY THIRD PARTY LICENSING THIRD PARTY 
SOFTWARE TO YOKOGAWA WITH RESPECT TO INFRINGEMENT OF THE INTELLECTUAL PROPERTY RIGHTS INCLUDING BUT NOT 
LIMITED TO, PATENT AND COPYRIGHT. 

 
Article 6 (Liabilities) 
6.1 If and when the Licensee should incur any damage relating to or arising out of the Licensed Software or service that Yokogawa has provided to 

the Licensee under the conditions herein due to a reason attributable to Yokogawa, Yokogawa shall take actions in accordance with this 
Agreement.  However, in no event shall Yokogawa be liable or responsible for any special, incidental, consequential and/or indirect damage, 
whether in contract, warranty, tort, negligence, strict liability, or otherwise, including, without limitation, loss of operational profit or revenue, loss 
of use of the Licensed Software, or any associated products or equipment, cost of capital, loss or cost of interruption of the Licensee’s business, 
substitute equipment, facilities or services, downtime costs, delays, and loss of business information, or claims of customers of Licensee or other 
third parties for such or other damages. Even if Yokogawa is liable or responsible for the damages attributable to Yokogawa and to the extent of 
this Article 6, Yokogawa’s liability for the Licensee’s damage shall not exceed the price amount of the Licensed Software or service fee which 
Yokogawa has received.  Please note that Yokogawa shall be released or discharged from part or all of the liability under this Agreement if the 
Licensee modifies, remodels, combines with other software or products, or causes any deviation from the basic specifications or functional 
specifications, without Yokogawa’s prior written consent. 

6.2 All causes of action against Yokogawa arising out of or relating to this Agreement or the performance or breach hereof shall expire unless 
Yokogawa is notified of the claim within one (1) year of its occurrence. 

6.3 In no event, regardless of cause, shall Yokogawa assume responsibility for or be liable for penalties or penalty clauses in any contracts between 
the Licensee and its customers. 

 
Article 7 (Limit of Export) 
Unless otherwise agreed by Yokogawa, the Licensee shall not directly or indirectly export or transfer the Licensed Software to any countries other than 
those where Yokogawa permits export in advance. 
 
Article 8 (Term) 
This Agreement shall become effective on the date when the Licensee receives the Licensed Software and continues in effect unless or until 
terminated as provided herein, or the Licensee ceases using the Licensed Software by itself or with Yokogawa’s thirty (30) days prior written notice to 
the Licensee. 
 
Article 9 (Injunction for Use) 
During the term of this Agreement, Yokogawa may, at its own discretion, demand injunction against the Licensee in case that Yokogawa deems that 
the Licensed Software is used improperly or under severer environments other than those where Yokogawa has first approved, or any other condition 
which Yokogawa may not permit. 
 
Article 10 (Termination) 
Yokogawa, at its sole discretion, may terminate this Agreement without any notice or reminder to the Licensee if the Licensee violates or fails to 
perform this Agreement.  However, Articles 5, 6, and 11 shall survive even after the termination. 
 
Article 11 (Jurisdiction) 
Any dispute, controversies, or differences between the parties hereto as to interpretation or execution of this Agreement shall be resolved amicably 
through negotiation between the parties upon the basis of mutual trust.  Should the parties fail to agree within ninety (90) days after notice from one of 
the parties to the other, both parties hereby irrevocably submit to the exclusive jurisdiction of the Tokyo District Court (main office) in Japan for 
settlement of the dispute. 
 
Article 12 (Governing Law) 
This Agreement shall be governed by and construed in accordance with the laws of Japan. The Licensee expressly agrees to waive absolutely and 
irrevocably and to the fullest extent permissible under applicable law any rights against the laws of Japan which it may have pursuant to the Licensee’s 
local law. 
 
Article 13 (Severability) 
In the event that any provision hereof is declared or found to be illegal by any court or tribunal of competent jurisdiction, such provision shall be null 
and void with respect to the jurisdiction of that court or tribunal and all the remaining provisions hereof shall remain in full force and effect. 
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Checking the Contents of the Package 
 

Unpack the box and check the contents before operating the instrument. If some of the 
contents are not correct, or if any items are missing or damaged, contact the dealer from 
whom you purchased them. 
 

Model Suffix Code Description 
731070  RFC2544 Test Application for the AE5511 
Language     -LNE English 

 
 
 

Contents of the Package 
• Software CD (RFC2544 Test Application CD for the AE5511): 1 
• User’s manual (this manual): 1 
 
 
 
 
 
 
 
 
 
 
 
 
 

Software CD User’s Manual 
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Conventions Used in This Manual 
 

Markings 
The following markings are used in this manual. 
 

Calls attention to information that is important for proper operation of 
the instrument. 

 
 

Subheadings 
On pages that describe the operating procedures in chapters 4 through 6, the following 
symbols, displayed characters, and terminology are used to distinguish the procedures 
from their explanations. 
 

Carry out the procedure according to the numbered steps.  All 
procedures are written with inexperienced users in mind; 
experienced users may not need to carry out all the steps. 

 
This section describes the setup items and the limitations regarding 
the procedures.  It may not give a detailed explanation of the 
function.  For a detailed explanation of the function, see chapter 2. 

 
Displayed Characters and Terminology Used in the Procedural Explanations 
• Software buttons: Bold characters Example) Click OK. 
• Parameters: Bold characters Example) Select TRAFFIC. 
• Switches: xxx switch Example) Press the power switch. 
• Hard keys: xxx key Example) Press the cursor key. 

 
Units 

k: Denotes 1000.  Example: 100 kHz and 10 kg 
K: Denotes 1024.  Example: 100 KB 
M: Denotes 1000000 if the unit is bps or Hz.  Example: 100 Mbps and 10 MHz 
 Denotes 1048576 if the unit is bytes.  Example: 100 MB 
G: Denotes 1000000000 if the unit is bps or Hz.  Example: 10 Gbps and 10 GHz 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Note 

Procedure 

Explanation 
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Product O
verview

 

111.1 Overview 
 

This software application is a software option for the AE5511 TrafficTesterPro that 
supports RFC2544, an industry standard for network device evaluation.  It can 
objectively evaluate the performance of network devices and improve the work 
efficiency through auto tests. 

 
Main Functions and Features 

• A RFC2544 performance auto test software for the AE5511 TrafficTesterPro. 
 
• The software application supports the four test modes defined in the RFC2544, 

throughput, latency, frame loss rate, and back-to-back. 
 
• The traffic map enables combinations of the traffic direction with respect to the DUT 

(unidirectional, bidirectional, or auto reverse) and the input/output of test ports 
(one-to-one or multi) to be set up. 

 
• One-step operation to execute the auto reverse test that can carry out performance 

tests on devices whose performance is different between uplink and downlink. 
 
• The test results can be verified on a numeric data table or graph.  The software 

application can also output the results to a report format convenient for creating test 
reports. 

 
Applicable Units 

This software application supports the following units. 
• AE5522 10GBASE-X Unit 
• AE5523 1000BASE-T Unit 
• AE5524 1000BASE-X Unit 
 
Note 

 AE5520 100BASE-T Unit and AE5521 1000BASE-X Units are not supported.  
Ports cannot be reserved on the AE5520 and AE5521. 
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2.1 Tests by DUT Type 
 

When you specify the DUT type, this software application automatically sends 
appropriate test frames and performs MAC address and IP address learning before 
starting the test.  This feature allows you to easily start the test.  For the operating 
procedure, see section 5.3. 

 
L2 Switch Test 

You can execute an L2 switch test by specifying L2 Switch for the DUT type.  In the L2 
switch test, a MAC address learning frame is sent between the pair of ports before the 
test. 
 
 
 
 
 
 
 
 
 
Note 

• 
• 

Three learning frames are sent to each opposite port at 0.1% of the wire speed.
The learning frames are resent until they reach the opposite port normally.  
Once they do, the AE5511 sends the test traffic. 

 
Because the destination MAC address of the transmitted frames is automatically set to 
the MAC address of the opposite port, you can easily start the test by specifying the port 
pair. 
 

IPv4 Router Test 
You can execute an IPv4 router test by specifying IPv4 router for the DUT type.  In the 
IPv4 router test, the AE5511 sends an ARP Request to the DUT port before starting the 
test.  The AE5511 automatically detects the MAC address of the DUT port from the 
ARP Reply received from the DUT and applies it to the test frames.  As with the L2 
switch test, learning frames can be sent to the DUT before the test or at each trial in the 
IPv4 router test. 
 
 
 
 
 
 
 
 
 
 
 
 
 
Note 

 The address resolution through ARP Request transmission is executed 
immediately after the measurement is started.  The AE5511 retries up to three 
times until the address is resolved normally. 
If the address is not resolved after three retrials, the AE5511 aborts the 
measurement. 

1) Send the learning frame AE5511 
DUT (L2 switch)

2) MAC address learning
3) Send the test traffic

The destination MAC address is automatically set to the MAC address of the 
opposite port. 

1) Send an ARP Request AE5511 DUT (IPv4 router)

2) ARP Reply 

3) Send the test traffic 

The destination MAC address is automatically set to the MAC address resolved by 
ARP. 
The destination IP address is automatically set to the IP address of the opposite port.
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Because the destination IP address of the transmitted frames is automatically set to the 
IP address of the opposite port, you can easily start the test by specifying the IP address 
of each port and the IP address of the destination router. 
 

IPv6 Router Test 
You can execute an IPv6 router test by specifying IPv6 router for the DUT type.  The 
IPv6 router test supports stateless address autoconfiguration.  As with the L2 switch 
test, learning frames can be sent to the DUT before the test or at each trial in the IPv6 
router test. 
 
Note 

 The AE5522 10GBASE-X Unit does not support the IPv6 router test. 
 
• Stateless address autoconfiguration operation 

Before starting the test, the AE5511 automatically detects the MAC address of the 
DUT port and the IP address of its own port by sending a Router Solicitation (RS) to 
the DUT port and receiving the Router Advertisement (RA) from the DUT.  The auto 
detected addresses are automatically applied to the test frames. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Note 

 The address resolution through RS transmission is executed immediately after 
the measurement is started.  The AE5511 retries up to three times until the 
address is resolved normally. 
If the address is not resolved after three retrials, the AE5511 aborts the 
measurement. 

 
Because the destination IP address of the transmitted frames is automatically set to the 
IP address of the opposite port, you can easily start the test by specifying the port pair. 
 
 
 
 
 
 
 
 

1) Send an RS DUT (IPv6 router)

2) RA reply

3) Send the test traffic

The destination MAC address is automatically set to the MAC address resolved by 
the RA response. 
The source IP address is automatically detected by the stateless address 
reconfiguration. 
The destination IP address is automatically set to the IP address of the opposite 
port. 

AE5511 
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2.2 Traffic Map Designation Function 
 

The software application supports one-to-one port traffic and multiple port traffic tests. 
Both tests support unidirectional and bidirectional tests.  The unidirectional test has an 
auto reverse function that tests the forward direction from the input ports to the output 
ports and then the reverse direction from the output ports to the input ports. 
For the operating procedure, see section 5.2. 
 
Note 

 The input port and output port indicate the traffic direction as seen from the DUT.
 

One-to-One Port Test 
The AE5511 generates test traffic between pairs of input and output ports in a 
one-to-one configuration. 
The unidirectional test generates traffic from the input ports and checks the received 
frames at the output ports. 
The bidirectional test generates traffic from both the input and output ports 
simultaneously and checks the received frames at the corresponding ports. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Note 

 In the throughput or back-to-back tests, the AE5511 indicates “Pass” if the 
frames sent from all input ports are received at all output ports within one test 
duration (or within the loss tolerance).  The AE5511 indicates “Fail” if a frame is 
lost (when the loss tolerance is zero) in any of the port pairs even if all frames 
pass between a given port pair. 

 
 
 
 
 
 
 
 

Input port 1 

Input port 2 

Input port 3 

Output port 4

Output port 5

Output port 6

AE5511 

DUT

Logic path 

Input port 1 

Input port 2 

Input port 3 

Output port 4 

Output port 5 

Output port 6 
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Multi Port Test 
The AE5511 generates test traffic between input and output ports in a mesh 
configuration. 
The unidirectional test generates traffic from the input ports and checks the received 
frames at the output ports. 
The bidirectional test generates traffic from both the input and output ports 
simultaneously and checks the received frames at the corresponding ports. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Note 

 Latency measurement cannot be executed in the multi port test. 
 
• Transmission timing from the input ports 

In the multi port test, frames are sent from all input ports simultaneously to the same 
output ports. 

 
 
 
 
 
 
 
 
 
 
 
 
Note 

• 
 

• 

The synchronization of the frame transmission is not guaranteed on the AE5522 
10GBASE-X Unit. 
If the transmission clock is changed with the transmission clock adjustment 
function, the synchronization of the frame transmission is not guaranteed. 

 
 
 

Input port 1 

Input port 2 

Output port 3

Output port 4

Output port 5

AE5511 

DUT

Logic path 

Input port 1 

Input port 2 

Output port 3 

Output port 4 

Output port 5 

Input port 1 

Time

To output port 

Start transmission 

Input port 2 To output port 

To output port To output port To output port To output port 

To output port To output port To output port To output port 



2.2  Traffic Map Designation Function 

IM 731070-01E  2-5 

22

E
xplanation of Functions

Unidirectional Test 
The unidirectional test generates traffic from the input ports and checks the received 
frames at the output ports. 
 
 
 
 
 
 
 
 
 
 

Bidirectional Test 
The bidirectional test generates traffic from both the input and output ports 
simultaneously and checks the received frames at the corresponding ports. 
 
 
 
 
 
 
 
 
 
 

Auto Reverse Test 
The auto reverse test first generates unidirectional traffic from the input ports and 
checks the received frames at the output ports.  Then, the test generates unidirectional 
traffic from the output ports and checks the received frames at the input ports. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Input port 1 

Input port 2 

Input port 3 

Output port 4

Output port 5

Output port 6

Input port 1 

Input port 2 

Output port 3

Output port 4

Output port 5

One-to-one Multi 

Input port 1 

Input port 2 

Input port 3 

Output port 4

Output port 5

Output port 6

Input port 1 

Input port 2 

Output port 3

Output port 4

Output port 5

One-to-one Multi 

Input port 1 

Input port 2 

Input port 3 

Output port 4

Output port 5

Output port 6

Input port 1 

Input port 2 

Output port 3

Output port 4

Output port 5

One-to-one (1st round) Multi (1st round) 

Input port 1 

Input port 2 

Input port 3 

Output port 4

Output port 5

Output port 6

Input port 1 

Input port 2 

Output port 3

Output port 4

Output port 5

One-to-one (2nd round) Multi (2nd round) 
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2.3 Operation Switch Function during 
Measurement Error 

 
The software application enables you to select whether to automatically stop the 
measurement when an error occurs during measurement or to continue the 
measurement if possible.  If a port-dependent error is detected, you can identify the 
port on the port status display. 
For the operating procedure, see section 5.3. 
 
The following types of measurement errors are available. 
 
(1) Address auto learn failure 

When the address auto learn fails during an IPv4 or IPv6 router test. 
(2) Link speed error 

When the link speed changes on a port during measurement. 
(3) Link down 

When a link down occurs on a port during measurement. 
(4) Learning frame failure 

When a response is not received after sending the retrial count of learning frames. 
(5) Received frames greater than transmitted frames 

When the number of received test frames is greater than the number of transmitted 
test frames. 

(6) Undelivered latency tag 
When the latency measurement source frame is lost. 

 
The following table shows how the AE5511 behaves when each error occurs. 

Error Operation Setting Measurement Error Item Status 
Display Stop Not Stop 

(1) Address auto learn failure - Stops the measurement Stops the measurement 
(2) Link speed error Red Stops the measurement Stops the measurement 
(3) Link down Red Stops the measurement Continues the measurement 
(4) Learning frame failure Red Stops the measurement Continues the measurement 
(5) Received frames greater 

than transmitted frames 
Red Stops the measurement Continues the measurement 

(6) Undelivered latency tag Red Continues the 
measurement 

Continues the measurement 

 
If error (1) or (2) occurs, the measurement stops even if the error operation setting is set 
to not stop, because the measurement cannot be continued. 
If error (6) occurs, the measurement continues regardless of the error operation setting. 
 
Note 

• 
 

• 

If a measurement error occurs, the AE5511 aborts the transmission operation of 
all ports for that test duration and indicates Fail. 
If Layer1 Setup of PORT1 to 12 on the AE5523 is set to auto negotiation, 
measurement starts by assuming a link speed of 10M on ports whose link is 
down at the time the measurement is started. 
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2.4 Measurement Functions 
 
This section describes the functional operation of the four measurement items, 
throughput, latency, frame loss rate, and back-to-back, that the software application 
supports. 
For the operating procedure, see section 5.3. 
 

Throughput Measurement Function 
The throughput measurement determines the maximum rate for each frame length that 
the network device can transmit without loss. 
In this measurement, frames are sent at a specific rate over a specific time (test 
duration).  If frames are lost, the rate is reduced.  If no frames are lost, the rate is 
increased.  This operation is repeated until the rate converges within a specified 
resolution range.  The operation that is repeated until the rate converges is considered 
a single trial.  The average of the results obtained by performing a specified number of 
trials is the throughput result. 
 
Note 

 In the throughput measurement, you can change the threshold level for detecting 
a loss by setting a loss tolerance. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Note 

 In some cases, the rate cannot be converged within a specified resolution range 
due to the resolution capability of the IFG setting of each unit.  The throughput 
measurement result includes quantization errors that depend on the resolution of 
the IFG setting of each unit. 

 

Send the test traffic 
DUT 

AE5511 

Receive the test traffic

If a loss occurs within the test duration, the next test traffic rate is reduced.
If a loss does not occur, the next test traffic rate is increased. 
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Latency Measurement Function 
The latency measurement determines the latency for each frame size when frames are 
sent through the DUT. 
In this measurement, only one of the frames sent in the middle of the test duration is 
used for the measurement.  The rate used during the measurement can be set to the 
rate of the throughput measurement result or a rate specified manually.  The latency 
measurement results can be displayed by selecting the cut through latency and store & 
forward latency. 
 
Note 

• 
 

• 
• 

If the rate is specified manually, the result is displayed for each rate within a 
specified range. 
Latency measurement cannot be executed in the multi port test. 
The display resolution of the latency measurement result is 0.1 µs, but the 
accuracy depends on the latency measurement capabilities of the unit. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
• Cut through latency 

The cut through latency indicates the time from when the first bit of the frame is sent 
from the AE5511 input port to when the bit is received at the output port. 

 
 
 
 
 
 
• Store & forward latency 

The store & forward latency indicates the time from when the last bit of the frame is 
sent from the AE5511 input port to when the first bit of the frame is received at the 
output port. 

 
 
 
 
 
 
Note 

• 
 

• 
 
 

• 

If the link speed is different between the input and output ports, the cut through 
latency will not be measured correctly. 
The result of the store & forward latency measurement is zero if the first bit of the 
frame is received at the output port before the last bit of the frame is sent from 
the input port. 
If none of the measurement source frame is received at the output port, the 
measurement result displays N/A. 

Send the test traffic 
DUT 

AE5511 

Receive the test traffic

Only one of the frames sent in the middle of 
the test duration is used for the measurement. 

Time 

1 trial 

Test duration

Frame sent from the input port

Frame received at the output port 

Cut through latency 

Time 

Time

Frame sent from the input port

Frame received at the output port

Store & forward latency 



2.4  Measurement Functions 

IM 731070-01E  2-9 

22

E
xplanation of Functions

Frame Loss Rate Measurement Function 
The frame loss rate measurement determines the frame loss rate for each frame length 
when traffic exceeding the transmission capability of the network device is applied. 
The frame loss rate is measured for each test rate while the rate is continuously reduced 
from the start rate of the test until no frames are lost. 
 
Note 

 Measurements for rates lower than the rate at which no frames are lost are 
omitted. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
The frame loss rate is calculated using the following equation. 
 
 
 
 
 

Te
st

 tr
af

fic
 

100% 
90% 

80% 
70% 

60% 
50% 

40% 

Fail Fail Fail Fail Fail Fail 
Pass 

Measurement is omitted for rates lower 
than the rate at which no frames are lost. 

Num of input frames –- Num of output frames 
Num of input frames 

Frame loss rate (%） = × 100 
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Back-to-Back Measurement Function 
The back-to-back measurement determines the maximum burst size for each frame 
length that the network device can tolerate without the loss of any frames. 
In this measurement, the number of burst frames is varied to determine the limit at which 
no frames are lost.  The operation to converge the trial result down to one frame 
resolution is considered a single trial.  The average of the results obtained by 
performing a specified number of trials is the back-to-back measurement result. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Note 

 The load during the burst is fixed to 100%. 
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2.5 File Function 
 

File Types 
The software application uses the following files. 
 

File Type File Format Extension SAVE LOAD Notes 
Setup file Binary r2s x x  
Result file Text csv x -  
Log File Text txt x -  

Binary cfx x - File format for Chart FX 
Text txt x - Text file (text only) 
Text xml x - XML file (properties only) 
Binary bmp x - BMP file 

Graph file 

Binary emf x - Meta file 
  x: Supported, -: Unsupported 
 

Setup File 
• Save 

Port pair settings, test configurations, DUT information settings, layer 1 setup of 
reserved ports, and network settings are saved. 
 
Directory path displayed by default 
C:\Program Files\RFC2544\RFC2544App\file\setup 

 
• Load 

The entire setup data is loaded collectively. 
If the port specified by the loaded file is not reserved, the port pair settings are reset 
to default. 
If a port that is not specified in the loaded file is reserved, the layer 1 setup and 
network settings are set to default. 

 
Result File 

• Save 
The measured results are saved in CSV format. 
The items that are saved are those that are displayed.  Save the result for each 
measurement item. 
 
Directory path displayed by default 
C:\Program Files\RFC2544\RFC2544App\file\Result 

 
• Load 

The result file cannot be loaded. 
 

Log File 
• Save 

The log results are saved in text format. 
 
Directory path displayed by default 
C:\Program Files\RFC2544\RFC2544App\file\log 
 

• Load 
The log file cannot be loaded. 
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Graph File 
• Save 

The graph display results are saved in a specified format. 
 
• Load 

The graph file cannot be loaded. 
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3.1 Notes on Using This Product 
 

The product CD (RFC2544 TestApplicationE CD for the AE5511) contains the software 
application that you install to the PC (RFC2544 TestApplicationE) and a license key for 
installing the RFC2544 option to the AE5511. 
 
You must install the RFC2544 option to the AE5511 to use this product.  You will be 
able to use the functions of this product by controlling the AE5511 with the RFC2544 
option from a PC that has the application (RFC2544 TestApplicationE) installed. 
 
• License Coverage 

This product can be used to install the RFC2544 option to a single AE5511.  The 
controller PC application (RFC2544 TestApplicationE) can be installed to an 
unlimited number of PCs. 

 
Note 

• 
 
 
 

• 

If the controller PC application (RFC2544 TestApplicationE) and the AE5511 
firmware version are not compatible, you may not be able to use the product 
even when you install the RFC2544 to the AE5511.  Please download the latest 
AE5511 firmware from YOKOGAWA’s Website and update the AE5511. 
User registration is required to download the firmware.  Please register at the 
following URL. 
http://www.yokogawa.com/tm/AE5511/ 
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3.2 Setting Up the Application 
 

System Requirements 
• PC: Windows PC 
• OS: Windows2000 SP3 or SP4 or Windows XP SP1 or SP2 
• CPU: Pentium III, 1.2 GHz or faster 
• Memory: 512 MB or more 
• Hard disk: Free space of 200 MB or more (300 MB or more recommended) 
• Disk drive: CD-ROM drive 
 
Note 

 A PC of higher specifications may be necessary if you are running this software 
application along with various firewalls and virus checking programs. 

 
 

Installing RFC2544 TestApplicationE to the PC 
1. Log in to Windows with administrator privileges. 
2. Load the software CD (RFC2544 TestApplicationE for the AE5511) into the CD-ROM 

drive. 
3. Double-click My Computer, and then double-click the CD-ROM icon.  The CD-ROM 

dialog box opens.  Double-click setup.exe on the CD-ROM.  The RFC2544 
TestApplicationE setup dialog box opens. 

 
 
 
 
 
 
 
 
 
 
4. Click Next. 
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5. Enter the customer information and click Next.  Specify the destination folder and 

click Next. 
 
 
 
 
 
 
 
 
 
 
 
6. On the Ready to Install the Program screen, click Install to start the installation. 
 
 
 
 
 
 
 
 
 
 
 
7. A message indicating that the installation has been completed appears.  Click 

Finish. 
 
 
 
 
 
 
 
 
 
 
 
 
Note 

 Microsoft .NET Framework is required to start the software application.  If the 
target PC does not have Microsoft .NET Framework installed, an installation 
menu automatically appears.  Install it according to the menu instructions. 
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Uninstalling RFC2544 TestApplicationE 
1. Log in to Windows with administrator privileges.  From the taskbar, click the 

Windows Start button, point to Settings, and click Control Panel.  Then, 
double-click Add or Remove Programs.  The Add or Remove Programs dialog box 
opens. 

2. Select RFC2544 TestApplicationE, and click Remove.  The Add/Remove Programs 
dialog box opens. 

 
 
 
 
 
 
 
3. Click Yes. 
 
 
 
 
 
 
4. The program is removed, and the message box automatically closes when the 

operation is complete. 
5. Uninstallation is finished when the message box closes. 
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3.3 Installing or Uninstalling the Option from 
the AE5511 

 
Installing the RFC2544 Option to the AE5511 

1. Start TTProControlWindowE, and log in to the AE5511 to which the RFC2544 option 
is to be installed as admin. 

2. From the Utility menu, point to Administrator Setup, point to Version Upgrade, 
and click Option Install.  The Install Option dialog box opens. 

 
 
 
 
 
 
 
 
 
3. Load the option installation CD into the CD-ROM drive, and click Ref.  The option 

file is shown. 
 
 
 
 
 
 
4. Click Install.  A dialog option opens indicating that the installation is complete. 
 
 
 
 
 
 
5. Click OK. 
6. In the Install Option dialog box, click Close. 
 
Note 

• 
• 

This product can be used to install the RFC2544 option to a single AE5511. 
To install the RFC2544 to another AE5511, uninstall the RFC2544 option from 
the AE5511 that has the option installed, or purchase an additional application. 

 
 
 



3.3  Installing or Uninstalling the Option from the AE5511 

3-6  IM 731070-01E 

Uninstalling the RFC2544 Option from the AE5511 
1. Start TTProControlWindowE, and log in to the AE5511 to which the RFC2544 option 

is to be uninstalled as admin. 
2. From the Utility menu, point to Administrator Setup, point to Version Upgrade, 

and click Option Uninstall.  The Uninstall Option dialog box opens. 
 
 
 
 
 
 
 
 
 
3. Select the option to be uninstalled from the Option Software List, and click Uninstall.  

A dialog box containing the message “Are you sure?” opens. 
 
 
 
 
 
 
 
 
 
 
4. Click OK.  The selected option is removed from the list. 
5. In the Uninstall Option dialog box, click Close. 
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4.1 Starting/Closing the Application 
 

To make RFC2544 measurements on the AE5511, start the RFC2544 TestApplicationE 
application on your PC.  Chapter 4 explains the operations on the main screen, the 
procedure to log in to the AE5511, the procedure to reserve the measurement ports to 
be used, and the procedure to start the measurement. 
 

Starting the Application 
 
 

1. On the taskbar, click the Windows Start button, point to All Programs, point to 
RFC2544 TestApplicationE, and click RFC2544AppE.  The application starts 
and a Login dialog box opens. 

 
• Connecting to the AE5511 

2. Click Add or Connect.  For the operating procedure, see section 4.2. 
 
• Creating the Setup Conditions on the PC 

2. Click Offline.  For the operating procedure, see chapter 5. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
• Starting the Application Using the Icon on the Desktop 

You can also double-click the RFC2544AppE icon on the desktop to start the 
application. 
 

 
 
 
 

 
 
 
 
 
 
 
 
 

Procedure 

Explanation 
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Closing the Application 
 
 

1. From the File menu, choose Exit.  A dialog box containing the message “Quit 
the application?" opens. 

 
 
 
 
 
 
 
 
2. Click Yes.  The application closes. 
 
 
 
 
 

Procedure 
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4.2 Login and Logout 
 

Login 
 
 

• Registering the Connection Destination 
1. In the Login dialog box, click Add.  The Connected Setup dialog box opens. 

 
 
 
 
 
 
 
 
 

2. Enter the destination information. 
(Example) Access Name: TTPro, IP Address: 192.168.0.1 

 User: admin 
 
 
 
 
 
 
 
 

3. Click OK.  The entered destination is registered. 
 
 
 
 
 
 
 
 
 
 
Note 

• 
 
 
 
 

• 
 

• 
• 
 

• 

When you enter admin in the User box, the application logs in to the AE5511 with 
administrator privileges.  However, admin setup functions used to configure the 
AE5511 with administrator privileges cannot be used on RFC2544 
TestApplicationE.  To use the admin setup functions, use TTPro 
ControlWindowE. 
Password is valid when Enable Password Function is specified in the AE5511 
Login Setup. 
Specify FTP Passive as necessary. 
If you are using the firewall function on Windows XP SP2 or a virus checking 
program, select the FTP Passive check box. 
If you wish to change the information after it is registered, click Edit. 
To delete the registered information, click Delete. 

 
 
 
 

Procedure 

Select the check 
box when using a 
firewall function 
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• Logging in to the Registered Destination 
1. Select the destination to which you wish to connect. 
 
 
 
 
 
 
 
 
 
 
2. Click Connect.  The Port Reserve dialog box opens.  See section 4.3. 
 

• Checking the Connection Using PING 
1. Select the destination to which you wish to connect. 
2. Click PING.  A command prompt screen (an accessory) on the PC automatically 

starts and the PING command is executed. 
3. Press any key.  The PC command prompt screen closes. 
 

 
 
• To log in from an offline condition, choose Login from the File menu. 
 
Note 

 You can also log in by clicking the Login icon. 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Explanation 
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Logout 
 
 

1. From the File menu, choose Logout.  The Logout dialog box opens. 
 
 
 
 

• Locking the port (logging out while retaining the measurement condition) 
2. Click Port Lock.  You are logged out. 
 

• Releasing the port (aborting the measurement condition and logging out) 
2. Click Port Release.  The Logout (Port Release) dialog box opens. 
 
 
 
 
 
 
3. Click OK.  You are logged out. 

 
Note 

• 
• 
 
 

• 
 

You can also log out by clicking the Logout icon. 
To log out while retaining the measurement condition, select Port Lock.  If you 
log out using Port Lock, you can reconnect with the conditions that existed when 
you logged out when you log in using the same user name. 
If you release the port, the measurement operation stops, and all the measured 
results and logs are cleared.  Save the measured results and settings as 
necessary.  For the operating procedure, see chapter 5. 

 
 
 
 
• If you log in to a destination that has been port locked, a dialog box with the message 

“Reserving locked ports.  Continue?” opens. 
 
 
 
 
 
 
 
Note 

• 
• 

The login mode is set to Port Lock by default on RFC2544 TestApplicationE. 
Port lock is a login mode in which the ports are reserved at all times. 

 
 
 
 
 
 

Procedure 

Explanation 
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4.3 Port Reserve 
 
Because the AE5511 is controlled from multiple PCs, be sure to reserve the necessary 
number of ports for the measurement when you log in.  This section explains the 
procedure to reserve the ports. 

 
 

1. Log in.  See section 4.2. 
 

• On the AE5523 and AE5524 
2. Select the unit port check boxes that are to be used for the measurement.  (In 

the example below, ports 1 and 2 are selected.) 
 
 
 
 
 
 
 
 
 
 
 
 
 

3. Click Reserve.  A dialog box containing the message “Load settings from the 
AE5511?” opens. 

 
 
 
 
 

4. Click OK.  The Download setup from AE5511 dialog box opens. 
 
 
 
 
 
 
5. Click OK.  The RFC2544 Test ApplicationE window opens. 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 

Procedure 

Click when using 
all ports 
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• On the AE5522 

2. Select a unit port check box or click Check All.  All ports on the unit are 
selected. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

3. Click Reserve.  A dialog box containing the message “The settings reload from 
the current settings of AE5511?” opens. 

4. Click OK.  The Download setup from AE5511 dialog box opens. 
5. Click OK.  The RFC2544 Test ApplicationE window opens. 

 
 
• Ports can be reserved individually on the AE5523 and AE5524. 
 
• Ports are reserved by units on the AE5522.  Even if you select the check box of a 

single port, all ports are selected. 
Note 

 The AE5520 and AE5521 are not supported by RFC2544 TestApplicationE.  
Ports cannot be reserved on the AE5520 and AE5521. 

 
• The Port Reserve screen shows the port reserve conditions of other users. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Item Description 
PORT  Reserved ports cannot be selected. 

Shows the login mode. Mode 
Normal: 
Auto:  
RFC2544: 

Logged in with TTProControlWindowE 
Logged in with auto test 
Logged in with the RFC2544 Test Application 

Address Shows the IP address. 
User Shows the user name. 

Explanation 
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4.4 Screen Description 
 

Main Screen 
The main screen consists of a Navigation Window, Screen Display Area, and various 
Windows bars. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

• Navigation Window 
This window is used to select or set the AE5511 ports. 

 
• View display area 

Displays the Setup View, Measurement/Result View, and Graph View. 
For details of each view in the view display area, see the following chapters. 

• Setup View See chapter 5. 
• Measurement/Result View See chapter 6. 
• Graph View See section 6.8. 

 
• Title bar 

Shows the status of the application screen and the online/offline state of the AE5511.  
When online, the device name and IP address are also shown. 

 
• Menu bar 

Shows the application menus for controlling the software. 
 
• Toolbar 

Shows the application toolbar containing icons for controlling the software. 
 
 
 
 

Title bar 
Menu bar 
Toolbar 

Navigation 
Window 

Status bar 

View display area Progress display area 
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• Status bar 

Shows the AE5511 status and descriptions of the menus and icons at the left edge.  
During measurement, the progress display area shows the progress of the test. 

 
 
 
 
 
 
 

No. Displayed Information Display Parameters 
(1) Measurements status 

display 
Run, Stop, and Error Stop 

(2) Current test item Finished, Throughput, Latency, Frame Loss 
Rate, and Back To Back 

(3) Measured frame size (in bytes) 
(4) Trial count during 

measurement 
Current trial count/specified trial count 

(5) Rate or number of burst 
frames during 
measurement 

Number of burst frames during back-to-back. 
Rate (%) for types other than back-to-back. 

 
Status Help Screen 

If you double-click a port on the Navigation Window, a Status Help screen opens.  This 
screen shows the usage of ports in color. 

 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Status Help Screen 
 
 
 
 
 
 
 
 
 
 
 

Shows the AE5511 status and 
descriptions of the menus and icons

(1) (2) (3) (4) (5)
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4.5 Switching the Views 
 

 
 

Switching the Setup, Measurement/Result, and Graph Views from the Menu 
• Displaying the Setup View 

From the View menu, choose Setup.  The view display area shows the Setup 
View. 

 
• Displaying the Measurement/Result View 

From the View menu, choose Measurement/Result.  The view display area shows 
the Measurement/Result View. 

 
• Displaying the Graph View 

From the View menu, choose Graph.  The view display area shows the Graph 
View. 
 

Note 
 The Graph View cannot be shown if there are no measured results. 

 
 

Switching the Setup, Measurement/Result, and Graph Views from the Toolbar 
Click the following buttons.  The same windows described above open. 
 
 
 
 
 Shows the Graph View 
 
 Shows the Measurement/Result View 
 
 Shows the Setup View 

 
 

Closing the Setup View 
From the File menu, choose Close Setup.  The Setup View in the view display area 
closes. 
 
 
 
 

 
 
 
 

Note 
 This command is used when setup is finished and there is no need to show the 

view during measurement. 
 
 
 

Procedure 
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4.6 Starting and Stopping Measurements 
 
The figure below shows the basic flow of operation until a measurement is started. 
This section explains the basic operation according to this flow chart. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Setting the Test Conditions 
 

1. Open the Setup View, and click TTP on the Navigation Window.  The Setup TTP 
view opens. 

2. Select the tabs in the Setup TTP view, and set the test conditions.  See chapter 5. 
3. After entering the settings, click Apply. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

• Set the test conditions
• Set port parameters

Apply the settings 

Setup

Start the measurement 

Procedure 

Click TTP 

Switch the tabs 
and set the test 
conditions 

After entering the 
settings, click 
Apply 
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Setting the Port Parameters 
 

1. On the Navigation Window, click the desired PORT number.  The Setup UNIT-n 
PORT-n view of the selected port opens. 

2. Select the tabs in the Setup UNIT-n PORT-n view, and set the port parameters.  See 
chapter 5. 

3. After entering the settings, click Apply. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Updating the Settings 
 

1. Click the Update icon or choose Update from the Control menu.  The Update 
dialog box opens. 

 
 
 
 
 
 
 
 
2. When the settings are updated, click OK. 

 
 
 
 
 
 

 

Procedure 

Click a port 
number 

Switch the tabs 
and set the port 
parameters 

After entering the 
settings, click 
Apply 

Update icon 

Click 

Procedure 
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Starting the Measurement 
 
 

Open the Measurement/Result View, and click the Start Measurement icon or choose 
Start Measurement from the Control menu.  The measurement starts. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The status indicator in the Navigation Window turns light blue to indicate that 
measurement is in progress.  In addition, the status bar shows the progress of the 
measurement.  You can switch the tabs in the Measurement/Result View to check the 
log and the result of each measurement item. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Procedure 

Measurement Start icon 

The status 
indicator turns 
light blue to 
indicate that the 
measurement is 
in progress. 

Switch the tabs to 
view the results 

Displays the progress of the measurement 
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Stopping the Measurement 
 
 

When all of the measurements are complete, the measurement automatically stops.  
To stop the measurement manually while the measurement is in progress, click the Stop 
Measurement icon or choose Stop Measurement from the Control menu. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Procedure 

Measurement Stop icon
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5.1 Setup View Configuration 
 

This section explains the relationship between the cursor positions on the Navigation 
Window and the Setup View configuration. 

 
 

Cursor Positions on the Navigation Window and the Setup View Configuration 
Cursor Position Setup tabs shown in the Setup View 
• TTP position 
 
 
 
 
 
 
 

• Port Pair 
• Test Configuration 
• DUT Info 

• UNIT position 
 
 
 
 
 
 
 

• Port Info 
• Common Port 
 

• PORT position 
 
 
 
 
 
 
 

• Layer1 Setup 
• Network Setup 
 

• Multiple Ports Selected 
 
 
 
 
 
 
 

• Common Port 

 
 
 
 
 
 
 
 
 
 
 
 

Explanation 
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Description of the Tabs in the Setup View 
• Port Pair 

The following items can be specified. 
• Online: Shows the information of the units that are installed (Unit Information). 
• Offline: Select the units to install virtually (Unit Information). 
• Set the test direction of the RFC2544 measurement (Traffic Map). 
• Set the combination of the ports used in the RFC2544 measurement (Port 

Selection). 
 

• Test Configuration 
The following items can be specified. 
• Set the type of device on which to perform the RFC2544 measurement. 
• Select the test items to be carried out in the RFC2544 measurement. 
• Set the frame length used in the RFC2544 measurement. 
• Set the details of each test of the RFC2544 measurement. 
 

• DUT Info 
The following item can be specified. 
• Information on the device on which to perform the RFC2544 measurement. 
* The information entered here is applied to the file output of the measured results. 

 
• Port Info 

A list of the following information is shown on the reserved ports under the selected 
unit. 
• Layer 1 setup information 
• Type of module installed 

 
• Common Port 

The layer 1 setup can be set collectively to the same values on multiple ports that 
are selected. 
* Port 13 on the AE5523 is an exception. 

 
• Layer1 Setup 

The following items can be specified. 
• Auto negotiation ON/OFF 
• Auto negotiation advertisement 
• MDI/MDI-X 
• Manual settings 

 
• Network Setup 

The following items can be specified. 
• MAC address of its own port 
• IPv4 address of its own port 
• IPv6 address of its own port 
• Auto learn DUT MAC address 
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5.2 Port Pair 
 

You can set the unit information, traffic map, and port selection in the Port Pair tab. 
For a functional explanation, see section 2.2. 

 
 

1. On the Navigation Window, click the instrument name. 
2. Click the Port Pair tab.  The Port Pair dialog box appears. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Unit Information 
The function of the Unit Information box is different between online mode and offline 
mode. 
 
• Offline mode 
 
 
 
 
 

3. In the UNIT1 and UNIT2 list, choose AE5522 10G*2Port, AE5523 
10M/100M/1000M*12Port+1000M*1Port, or AE5524 1000M*12Port. 

 
• Online mode 
 
 
 
 
 

Shows the unit that is installed in UNIT1 and UNIT2. 
 
 
 

Procedure 
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Traffic Map 
 
 
 
 
 

4. In the list, select 1to1 (Unidirectional), 1to1 (Bidirectional), 1to1 (Auto Reverse), 
Multi (Unidirectional), Multi (Bidirectional), or Multi (Auto Reverse). 

Port Selection 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
• Setting the input ports 

5. In the Vacant Ports list, click the port you want to set to input port. 
6. Click To Input.  The selected port is shown in the Input Ports list. 

• Setting the output ports 
7. In the Vacant Ports list, click the port you want to set to output port. 
8. Click To Output.  The selected port is shown in the Output Ports list.  If there 

are ports you want to delete, proceed to step 9.  Otherwise, proceed to step 13. 
 
• Removing ports from the input ports 

9. In the Input Ports list, click the port you want to remove. 
10. Click From Input.  The selected port is removed from the Input Ports list. 

• Removing ports from the output ports 
11. In the Output Ports list, click the port you want to remove. 
12. Click From Output.  The selected port is removed from the Output Ports list. 

 
• Updating the Settings 

13. Click Apply.  The data is applied on the application. 
14. Click the Update icon or choose Update from the Control menu. 

 
Note 

• 
 

• 
• 

If the traffic map is one-to-one, the pair of ports in the same line in the Input Ports 
and Output Ports list becomes a port pair. 
You can set multiple port pairs. 
When selecting the ports to be assigned or removed, you can select multiple 
ports by clicking ports while holding down the Ctrl or Shift key. 
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5.3 Test Configuration 
 

You can specify common setup and setup for each test in the Test Configuration tab. 
For a functional explanation, see sections 2.1, 2.3, and 2.4. 

 
 

1. On the Navigation Window, click the instrument name. 
2. Click the Test Configuration tab.  The Test Configuration dialog box appears. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Common Setup 
• Setting the DUT type 

3. In the list, select L2 Switch, IPv4 Router, or IPv6 Router. 
 
• Setting the test 

4. Select the check boxes for the parameters to be tested. 
 

Note 
 Latency cannot be selected if Traffic Map in the Port Pair tab is set to Multi. 

 
• Setting the error handling 

5. Select the check box to stop the test when an error occurs. 
 

Note 
 The applicable errors are address auto learn failure, learning frame failure, link 

down, and when the number of sent frames is less than the number of received 
frames. 

 
 
 
 

Procedure 
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• Setting the test frame length 
• Setting the test frame length to default 
 
 
 
 
 
 
 
 
 
6. In the Type list, select Default.  Values are shown in the Number of Sizes box 

and frame length entry area and cannot be changed. 
Note 

• 
 

• 
 
 
 
 
 

• 

When the text frame length is set to default, the number of sizes, the frame 
length, and the frame order are fixed and cannot be changed. 
The number of sizes and the frame length values vary depending on the DUT 
Type setting. 
• L2 Switch or IPv4 Router: 

Number of sizes: 7.  Frame lengths: 64, 128, 256, 512, 1024, 1280, and 1518.
• IPv6 Router: 

Number of sizes: 6.  Frame lengths: 128, 256, 512, 1024, 1280, and 1518. 
The tests are executed in order from No. 1. 

 
• Setting the test frame length to custom 
 
 
 
 
 
 
 
 
 
6. In the Type list, select Custom. 
7. In the Number of Sizes box, enter a value between 1 and 25.  The specified 

number of data values is shown in the No. and Length areas. 
8. Click the No. line containing the frame length you want to change, and click the 

value in the Length box.  The value in the Length box can now be changed. 
9. Enter the value in the Length box. 
 

Note 
• 
 
 
 

• 
 

• 

The range of the frame length that can be specified varies depending on the 
DUT Type setting. 
• L2 Switch or IPv4 Router: 64 to 9999 
• IPv6 Router: 84 to 9999 
You can change the order of the frame lengths by selecting a line and clicking 
the ▲ or ▼ button. 
The tests are executed in order from No. 1. 
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• Setting the test frame length to steps 
 
 
 
 
 
 
 
 
 
6. In the Type list, select Step. 
7. In the Initial box, enter the frame length at the start of the test. 
8. In the Step box, enter the step value (a value that is added to the frame length 

for each test). 
9. In the Steps box, enter the number of times to change the frame length. 
 

Note 
• 
 
 
 

• 

The range of the frame length that can be specified varies depending on the 
DUT Type setting. 
• L2 Switch or IPv4 Router: 64 to 9999 
• IPv6 Router: 84 to 9999 
The range of values that can be entered in each box is limited so that Step × 
Steps + Initial is less than or equal to 9999. 

 
• Setting the learning frame 

10. In the Learning Mode list, select Never, Once, or Every trial. 
11. In the Retries box, enter the number of retries when an error occurs in the range 

of 1 to 999. 
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Setup for Each Test > Throughput 
12. In Setup for Each Test, click the Throughput tab. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
13. In the Test Duration box, enter a value between 1 and 999 (Sec). 
14. In the Trials box, enter a value between 1 and 60. 
15. In the Initial Rate box, enter the traffic rate at the start of the test in the range of 

0.10 to 100.00 (%). 
16. In the Resolution box, enter the range to which the test result is to converge in 

the range of 0.01 to 100.00 (%). 
17. In the Min. Rate box, enter the minimum rate to which the test result is to 

converge in the range of 0.01 to 100.00 (%).  Enter a value less than or equal 
to the Initial Rate. 

18. In the Max. Rate box, enter the maximum rate to which the test result is to 
converge in the range of 0.01 to 100.00 (%).  Enter a value greater than or 
equal to the Initial Rate. 

19. In the Loss Tolerance box, enter the amount of lost frames that is allowed during 
the test in the range of 0.01 to 100.00 (%). 
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Setup for Each Test > Latency 
12. In Setup for Each Test, click the Latency tab. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
13. In the Test Duration box, enter a value between 1 and 999 (Sec). 
14. In the Trials box, enter a value between 1 and 60. 
 

• Setting the test rate to auto (result of the throughput rate) 
15. Select the Result of Throughput Rate test box.  This is available when the 

Throughput check box is selected under Test. 
 

• Setting the test rate manually 
15. Clear the Result of Throughput Rate check box. 
 
 
 
 
 
 
 
 
 
 
 
 
16. In the Initial box, enter the traffic rate at the start of the test. 
17. In the Step-Up Rate box, enter the rate that is added for each test. 
18. In the Steps box, enter the number of times to change the traffic rate. 
 

Note 
 The range of values that can be entered in each box is limited so that Step-Up 

Rate × Steps + Initial Rate is less than or equal to 100.00. 
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Setup for Each Test > Frame Loss Rate 
12. In Setup for Each Test, click the Frame Loss Rate tab. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
13. In the Test Duration box, enter a value between 1 and 999 (Sec). 
14. In the Trials box, enter a value between 1 and 60. 
15. In the Initial box, enter the traffic rate at the start of the test. 
16. In the Step-Down Rate box, enter the rate that is subtracted for each test. 

Note 
 The range of values that can be entered in each box is limited so that Initial Rate 

is greater than Step-Down Rate. 
 
 
 
 
 
 
 



5.3  Test Configuration 

IM 731070-01E  5-11 

55

Setup 

Setup for Each Test > Back To Back 
12. In Setup for Each Test, click the Back To Back tab. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
13. In the Test Duration box, enter a value between 1 and 999 (Sec). 
14. In the Trials box, enter a value between 1 and 60. 
 
 

• Updating the Settings 
20. Click Apply.  The data is applied on the application. 
21. Click the Update icon or choose Update from the Control menu. 
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5.4 DUT Info 
 

You can set character strings for the vender name, product name, serial number, and 
comment that are output in the result file in the DUT Info tab. 

 
 

1. On the Navigation Window, click the instrument name. 
2. Click the DUT Info tab.  The DUT Info dialog box appears. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
3. Enter the vender name, product name, serial number, and comment 

(alphanumeric characters and symbols). 
 

• Updating the Settings 
4. Click Apply.  The data is applied on the application. 
5. Click the Update icon or choose Update from the Control menu. 
 

Note 
• 
 

• 

You can enter up to 31 alphanumeric characters and symbols for the vender 
name, product name, and serial number. 
You can enter up to 63 alphanumeric characters and symbols for the comment. 

 
 
 
 
 

Procedure 
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5.5 Layer1 Setup 
 

You can set auto negotiation on the reserved ports in the Layer1 Setup tab. 
 
 

1. On the Navigation Window, click the desired PORT number.  The Setup 
UNIT-n PORT-n view of the selected port opens. 

2. Click the Layer1 Setup tab.  The Layer1 Setup dialog box appears. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Auto Negotiation 
The displayed items vary depending on the unit. 
 
• Enabling Auto Negotiation 
 
 
 
 
 
 
 
 
 
 
 
 

3. Select the Enable Auto Negotiation check box.  The check boxes for 
advertisements that can be used are selected. 

4. Clear the check boxes for unneeded advertisements. 
5. If the interface is T, select MDI, MDI-X, or AUTO in the MDI/MDI-X box. 

 
 
 
 

Procedure 
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• Disabling Auto Negotiation 
 
 
 
 
 
 
 
 
 
 

3. Clear the Enable Auto Negotiation check box.  The Manual setup parameters 
become available. 

4. Select the appropriate parameters in the Speed, DUPLEX, and FLOW 
(PAUSE) boxes. 

5. If the interface is T, select MDI or MDI-X in the MDI/MDI-X box.   
 

• Updating the Settings 
6. Click Apply.  The data is applied on the application. 
7. Click the Update icon or choose Update from the Control menu. 
 

 
 
 

• The parameters that you can specify vary depending on the installed unit. 
Unit*1 
22 23*2 24Parameter 

Input 
Method 

Input Range/ 
Selection 

 1-12 13  
Description 

Auto Negotiation       
Auto Negotiation Check box ON/OFF - x x x  

Advertisement       Available when Auto Negotiation 
is enabled 

10M-Half Check box ON/OFF - x - -  
10M-Full Check box ON/OFF - x - -  
100M-Half Check box ON/OFF - x - -  
100M-Full Check box ON/OFF - x - -  
1000M-Full Check box ON/OFF - x - -  
Flow(Symmetric) Check box ON/OFF - x x x  
Flow(Asymmetric) Check box ON/OFF - x x x  

Manual       Available when Auto Negotiation 
is disabled 

Speed Drop-down list 10M/100M/1000M - x - -  
DUPLEX Drop-down list FULL/HALF - x - - Fixed to FULL when the speed on 

the AE5523 is 1000M. 
FLOW(PAUSE) Drop-down list ON/OFF x x x x  
MDI/MDI-X Drop-down list MDI/MDI-X/AUTO - x - -  

x: Supported, -: Unsupported 
 

*1: Unit.  22: AE5522, 23: AE5523, and 24: AE5524 
*2: “1-12” of the AE5523 represent the parameters for PORT1 to PORT12, and “13” represents PORT13. 

 

Select from the list Clear 

Select from the list 

Explanation 
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5.6 Network Setup 
 

This section explains the details of setting the port addresses of the reserved ports and 
the IPv4/IPv6 emulation function. 

 
 
 

1. On the Navigation Window, click the desired PORT number.  The Setup 
UNIT-n PORT-n view of the selected port opens. 

2. Click the Network Setup tab.  The Network Setup dialog box opens. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Own Port Address Setup 
• Setting the MAC address 

• Using a Global MAC Address 
3. Select the Use Global MAC address check box.  The MAC address boxes 

become unavailable.  Proceed to step 5. 
 

• Using a local MAC address 
3. Clear the Use Global MAC address check box.  The MAC address boxes 

become available. 
4. Type the local MAC address in the boxes in hexadecimal notation. 

 
• Setting the IPv4 address 

5. Type the IPv4 address in the IPv4 Address box. 
 
• Setting the IPv6 address (AE5523 and AE5524) 

• Enabling stateless address auto configuration 
6. Select the Enable Stateless Address Autoconf check box.  The IPv6 

address boxes become unavailable.  Proceed to step 8. 
 
 
 

Procedure 
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• Disabling stateless address auto configuration 
6. Clear the Enable Stateless Address Autoconf check box.  The IPv6 address 

boxes become available. 
7. Type the IPv6 address in the IPv6 Address box.  Proceed to step 8. 

Note 
 To automatically configure the source IP address, select the Enable Stateless 

Address Autoconf check box. 
 

Auto Learn DUT MAC Address 
• Enabling IPv4 emulation 

8. The Enable Auto Learn check box is always selected. 
9. Type the target IP address in the Target box. 

 
• Enabling IPv6 emulation (AE5523 and AE5524) 

10. The Gateway MAC Address Auto Learn check box is always selected. 
 

• Updating the Settings 
11. Click Apply.  The data is applied on the application. 
12. Click the Update icon or choose Update from the Control menu. 

 
 
 

Parameter Input 
Method 

Input Range/Selection Description 

Own Port Address Setup   
MAC Address    

Use Global MAC 
Address 

Check box ON/OFF Selects whether to use a global MAC address. 
• ON: Use a global MAC address. 
• OFF: Not use the global MAC address. 

MAC Address Text box 000000000000 to  
FFFFFFFFFFFF (HEX) 

Sets the MAC address.  Available when the Use 
Global MAC Address check box is not selected. 

IPv4 Address Text box 0.0.0.0 to 255.255.255.255 Sets the IPv4 address. 
IPv6 Address    

Enable Stateless 
Address Autoconf 

Text box ON/OFF Selects whether to use stateless address auto 
configuration.  This function is available on the 
AE5523 and AE5524. 
• ON: Enables stateless address auto 

configuration. 
• OFF: Disables stateless address auto 

configuration. 
IPv6 Address Text box 000000000000000000000

00000000000 to 
FFFFFFFFFFFFFFFFFFF
FFFFFFFFFFFFF (HEX) 

Sets the IPv6 address.  Available on the AE5523 
and AE5524 when the Enable Stateless Address 
Autoconf check box is not selected. 

Auto Learn DUT MAC Address   
IPv4    

Enable Auto Learn Check box ON Carries out MAC address auto learn of the DUT 
port. 

Target Text box 0.0.0.0 to 
255.255.255.255 

Sets the MAC address of the DUT port.  Available 
when the Enable Auto Learn check box is selected.

IPv6    
Gateway MAC 
Address Auto Learn 

Check box ON Carries out MAC address auto learn of the 
gateway.  This function is available on the AE5523 
and AE5524. 

Explanation 
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5.7 Common Port 
 
If multiple ports are reserved, common port settings can be specified.  Common port 
settings enable the auto negotiation settings of the reserved ports to be specified 
collectively. 

 
 

1. On the Navigation Window, click the desired UNIT number.  Or click multiple 
port numbers.  The Setup UNIT-n window of the selected unit opens. 

2. Click the Common Setup tab.  The Common Setup screen appears. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
• Setting the Auto Negotiation 

1. Enable or disable auto negotiation, and make selections under MDI/MDI-X, 
advertisement, and manual setup.  For details, see auto negotiation in section 
5.5. 

 
2. Click Register.  A dialog box containing the message “Common port setup was 

completed.” opens. 
 
 
 
 
 

3. Click OK. 
 

• Updating the Settings 
4. Click Apply.  The test mode selected on the application is shown. 
5. Click the Update icon or choose Update from the Control menu. 

 
 
Note 

• 
• 
 

• 

Common port settings do not appear if only one port is reserved. 
The settings on the Common Setup screen are not held.  The settings are reset 
to default values when you switch the tab. 
PORT13 of the AE5523 is excluded from the common port settings. 

 

Procedure 

Click 
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Explanation 
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5.8 Loading and Saving the Setup File 
 

This section explains the details of loading, and saving the setup files of the AE5511. 
Loading the Setup File 

 
 
1. From the File menu, choose Load Setup File.  A dialog box containing the 

message "Current settings will be cleared. OK?" opens. 
 
 
 
 
 
 
• When Loading the Setup File 

2. Click Yes.  The Open dialog box opens. 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
3. Select the setup file you wish to load and click Open.  A dialog box containing 

the message “File load completed successfully.” opens. 
 
 
 
 
 

4. Click OK.  The original screen appears. 
 
• When Not Loading the Setup File 

2. Click No.  The original screen appears. 
 
 
• A setup file that has been saved on the PC is loaded on the application. 
 
• The items that are loaded from a setup file are as follows: 

 Item 
Setup file Version information, port pair, test configuration, DUT info, layer 

1 setup, and network setup. 
 

 

Procedure 

Explanation 
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• Setup files of different units 

• Items that can be set are loaded. 
• Items not in the setup file are set to their default values. 
• Items in the setup file but not available on the unit are not loaded. 

Note 
 If a setup file of a different unit is loaded, a Default List is shown. 

 
• Setup files of different ports 

• Port in the setup file but is not reserved 
Unreserved ports are removed from the port pair settings. 

• Port not in the setup file but is reserved 
Layer1 setup and network setup are set to their default values. 

Note 
 If a setup file with different port conditions is loaded, a message appears. 

 
• You can also load the setup file by right-clicking on the Navigation Window. 
 
Note 

 The AE5511 settings are not updated at the time the file is loaded.  To update 
the AE5511 settings, use the Update command. 
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Saving the Setup 
 

 
1. From the File menu, choose Save Setup.  The Save As dialog box opens. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
• When Saving the Setup File 

2. Type the file name and click Save.  A dialog box containing the message “File 
save completed successfully.” opens. 

 
 
 
 

 
3. Click OK.  The original screen appears. 

 
• When Not Saving the Setup File 

2. Click Cancel.  The original screen appears. 
 
 
• The setup data on the application can be saved as setup files on the PC. 
 
• In online mode, all ports that are reserved are saved.  In offline mode, all ports are 

saved. 
 
• The items that are saved to the setup file are as follows: 

 Item 
Setup file Version information, port pair, test configuration, DUT info, layer 

1 setup, and network setup. 
 
• You can also save the setup file by right-clicking on the Navigation Window. 
 
 
 
 
 
 
 
 
 
 

Procedure 

Explanation 
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5.9 Copying and Pasting Setup Data 
 
This section explains the details of copying the setup data of one port to another port. 

 
 

• Copying 
1. On the Navigation Window, click the PORT number of the setup data copy 

source. 
 
 
 
 
 
 

2. From the Edit menu, choose Copy. 
 
• Pasting 

3. Click the PORT number of the copy destination. 
4. From the Edit menu, choose Paste.  The setup data is copied. 
 

Note 
 If a setup file of a different unit is copied and pasted, Default List may be shown.

 
 
 
• You can also copy the setup data by right-clicking on the Navigation Window. 
 
• The following parameters are copied. 

 Item 
Setup file Layer 1 setup and network setup. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Procedure 

Explanation 
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5.10 Restoring the Default Settings 
 

This section explains the details of restoring the default settings. 
 
 

1. On the Navigation Window, click the instrument name, UNIT number, or PORT 
number for restoring the settings. 

 
 
 
 
 
 

2. Click the  icon or choose Default from the Edit menu.  A dialog box 
containing the message “Reset settings to default?” opens. 

 
 
 
 
 
• When restoring the default settings 

3. Click Yes.  The settings are reset to default. 
 
• When not restoring the default settings 

3. Click No.  The original screen appears. 
 
 
• The ports that are reset vary between online mode and offline mode.  In addition, 

the ports that are reset vary depending on the specified type of operation. 
Ports That Are Reset Type 
Online Mode Offline Mode 

Entire instrument 
(Instrument name) 

All reserved ports 
Port pair, test configuration, and DUT 
information are also reset. 

All ports 
Port pair, test configuration, and 
DUT information are also reset.

Unit level 
(UNIT number) 

Reserved ports on the specified unit 
Only Layer1 setup and network setup 
are reset. 

All ports on the specified unit 
Only Layer1 setup and network 
setup are reset. 

Port level 
(PORT number) 

Specified ports that are reserved 
Only Layer1 setup and network setup 
are reset. 

Specified ports 
Only Layer1 setup and network 
setup are reset. 

 
• You can also restore the settings by right-clicking on the Navigation Window or 

clicking Default on the Setup window. 
 
 
 
 
 
 
 
 

Procedure 
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6.1 Measurement/Result View 
 

This chapter explains the displaying and saving of the measured results. 
For the procedure to set the measurement conditions, see chapter 5.  For the 
procedure to start/stop the measurement, see section 4.6. 
This section explains the Measurement/Result View. 

 
 

1. From the View menu, choose Measurement/Result.  The view display area shows 
the Measurement/Result View. 

 
 
 
 
 
 
 
 
 
 
 
 
Note 

 You can also click the Measurement/Result icon to display the 
Measurement/Result View. 

 
2. Click each measurement item tab in the Measurement/Result View.  The 

Measurement/Result View of the clicked tab is shown. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
• For throughput and latency measurements 
3. Click a Unit option button.  The measured results are displayed with the selected 

unit. 
 
• When Traffic Map of Port Pair is set to 1to1 (Auto Reverse) or Multi (Auto Reverse) 
4. Click a Direction option button.  The measured results are displayed for the 

selected direction (excluding the log).   
 
 
 
 

Procedure 
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• The Measurement/Result View can be shown only when logged in. While logged it, 
the view can be displayed regardless of whether the measurement is in progress. 

 
• The measurement items selected under Test in the Test Configuration tab are shown 

as tabs.  Those that are not selected are not shown. 
 
• For measurement result views other than the log, the measurement conditions are 

shown in the Setup area. 
 
• If the measurement is in progress, the measured results that have completed the 

measurement are displayed as they become available. 
 
• Operations on the Measurement/Result View does not affect the measurement 

operation in progress.  However, the Measurement/Result View cannot be closed 
while the measurement is in progress. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Explanation 
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6.2 Throughput Result View 
 
 

1. Click the Throughput tab in the Measurement/Result View.  The measured results 
of throughput are shown. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
• When Traffic Map of Port Pair is set to 1to1 (Auto Reverse) or Multi (Auto Reverse) 
2. Click a Direction option button.  The measured results for the selected direction are 

displayed .  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
3. Click a Unit option button.  The measured results are displayed with the selected 

unit. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Procedure 
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• The measured result shows the average value of the convergence result for the 
number of trials for each frame length. 

 
• The measurement result display varies depending on the unit selection and traffic 

map setting as follows: 
Unit Selection Traffic Map Setting Displayed Measured Results 
% All Shows the throughput (%) for each frame length. 

1to1 (Unidirectional) Shows in the selected unit (frames/s or bits/s) the 
throughput (%), the frame rate or bit rate 
(input-to-output direction) of each port pair, and the 
total frame rate or bit rate of all ports in the 
input-to-output direction for each frame length. 

1to1 (Bidirectional) Shows in the selected unit (frames/s or bits/s) the 
throughput (%), the frame rate or bit rate 
(input-to-output and output-to-input directions) of 
each port pair, and the total frame rate or bit rate of all 
ports in the input-to-output and output-to-input 
directions for each frame length. 

1to1 (Auto Reverse) Shows in the selected unit (frames/s or bits/s) the 
throughput (%), the frame rate or bit rate (only in the 
selected direction) of each port pair, and the total 
frame rate or bit rate of all ports in the selected 
direction for each frame length. 

Multi (Unidirectional) Shows in the selected unit (frames/s or bits/s) the 
throughput (%), the sum of the frame rates or bit 
rates of the input port, and the total frame rate or bit 
rate of all input ports for each frame length. 

Multi (Bidirectional) Shows in the selected unit (frames/s or bits/s) the 
throughput (%), the sum of the frame rates or bit 
rates of each input port, the sum of the frame rates or 
bit rates of the output port, and the total frame rate or 
bit rate of all input and output ports for each frame 
length. 

frame/s 
bit/s 

Multi (Auto Reverse) Shows in the selected unit (frames/s or bits/s) the 
throughput (%), the sum of the frame rates or bit 
rates of each input port or output port (only in the 
selected direction), and the total frame rate or bit rate 
of all input or output ports in the selected direction for 
each frame length. 

* Unit number x (where x is 1 or 2) and port number y (where y is a number between 
01 and 13) are displayed as UxPy. 

* Input port: Input-to-output direction.  Output port: Output-to-input direction. 
 

• The unit and direction can be changed regardless of whether the measurement is in 
progress.  The changing of the unit and direction does not affect the measurement 
operation. 

 
• The measured results of multiple ports are displayed in the order specified in the Port 

Pair settings. 
 
• The graph shown by the graph display function varies depending on the selected unit.  

For details, see section 6.8. 
 

Explanation 
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6.3 Latency Result View 
 
 

1. Click the Latency tab in the Measurement/Result View.  The measured results of 
latency are shown. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
• When Traffic Map of Port Pair is set to 1to1 (Auto Reverse) or Multi (Auto Reverse) 
2. Click a Direction option button.  The measured results for the selected direction are 

displayed .  
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3. Click a Unit option button.  The measured results are displayed with the selected 
unit. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

• The measured results are displayed with a display resolution of 0.1 µs for each frame 
length and test rate. 

 
• The latency measurement results are displayed for the Cut Through and Store & 

Forward methods by selecting the unit. 
 
• The measurement result display varies depending on traffic map setting as follows: 

Traffic Map Setting Displayed Measured Results 
1to1 (Unidirectional) Shows in the selected unit (cut through or store & forward) the latency of 

each port pair (input-to-output direction) and the average of the latencies of 
all ports in the input-to-output direction for each frame length and test rate. 

1to1 (Bidirectional) Shows in the selected unit (cut through or store & forward) the latency of 
each port pair (input-to-output and output-to-input directions) and the 
average of the latencies of all ports in the input-to-output and output-to-input 
directions for each frame length and test rate. 

1to1 (Auto Reverse) Shows in the selected unit (cut through or store & forward) the latency of 
each port pair (only in the selected direction) and the average of the latencies 
of all ports in the selected direction for each frame length and test rate. 

* Unit number x (where x is 1 or 2) and port number y (where y is a number 
between 01 and 13) are displayed as UxPy. 

 
• The result shows ‘N/A’ if a measured result could not be obtained such as due to lost 

packets.  Such measured results are excluded from the average calculation. 
 
• The unit and direction can be changed regardless of whether the measurement is in 

progress.  The changing of the unit and direction does not affect the measurement 
operation. 

 
• The measured results of multiple ports are displayed in the order specified in the Port 

Pair settings. 
 
• The graph shown by the graph display function varies depending on the selected unit.  

For details, see section 6.8. 
 

Explanation 
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6.4 Frame Loss Rate Result View 
 
 

1. Click the Frame Loss Rate tab in the Measurement/Result View.  The measured 
results of frame loss rate are shown. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
• When Traffic Map of Port Pair is set to 1to1 (Auto Reverse) or Multi (Auto Reverse) 
2. Click a Direction option button.  The measured results for the selected direction are 

displayed.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Procedure 
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• The measured results are displayed with three digits to the right of the decimal point 
for each frame length and test rate. 

 
• If the measured result is negative, the word “Err” is displayed, and the measurement 

is carried out in the next frame length. 
 
• The measurement result display varies depending on traffic map setting as follows: 

Traffic Map Setting Displayed Measured Results 
1to1 (Unidirectional) Shows the frame loss rate of each port pair (input-to-output 

direction) and the average of the frame loss rates of all ports in the 
input-to-output direction for each frame length and test rate. 

1to1 (Bidirectional) Shows the frame loss rate of each port pair (input-to-output and 
output-to-input directions) and the average of the frame loss rates of 
all ports in the input-to-output and output-to-input directions for each 
frame length and test rate. 

1to1 (Auto Reverse) Shows the frame loss rate of each port pair (only in the selected 
direction) and the average of the frame loss rates of all ports in the 
selected direction for each frame length and test rate. 

Multi (Unidirectional) Shows the average frame loss rate of each input port and the 
average frame loss rate of all input ports for each frame length and 
test rate. 

Multi (Bidirectional) Shows the average frame loss rate of each input port, the average 
frame loss rate of each output port, and the average frame loss rate 
of all input and output ports for each frame length and test rate. 

Multi (Auto Reverse) Show the average frame loss rate of each input port or output port 
(only in the selected direction) and the average frame loss rate of all 
input or output ports (only in the selected direction). 

* Unit number x (where x is 1 or 2) and port number y (where y is a number 
between 01 and 13) are displayed as UxPy. 

* Input port: Input-to-output direction.  Output port: Output-to-input direction. 
 
• The unit and direction can be changed regardless of whether the measurement is in 

progress.  The changing of the unit and direction does not affect the measurement 
operation. 

 
• The measured results of multiple ports are displayed in the order specified in the Port 

Pair settings. 
 
 
 
 
 
 
 
 

Explanation 
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6.5 Back-to-Back Measurement Result 
 
 

1. Click the Back To Back tab in the Measurement/Result View.  The back-to-back 
measured results are shown. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

• When Traffic Map of Port Pair is set to 1to1 (Auto Reverse) or Multi (Auto Reverse) 
2. Click a Direction option button.  The measured results for the selected direction are 

displayed.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Procedure 
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• The measurement result display varies depending on traffic map setting as follows: 

Traffic Map Setting Displayed Measured Results 
1to1 (Unidirectional) Shows the back-to-back frames of each port pair (input-to-output 

direction) and the total back-to-back frames of all ports in the 
input-to-output direction for each frame length. 

1to1 (Bidirectional) Shows the back-to-back frames of each port pair (input-to-output and 
output-to-input directions) and the total back-to-back frames of all ports 
in the input-to-output and output-to-input directions for each frame 
length. 

1to1 (Auto Reverse) Shows the back-to-back frames of each port pair (only in the selected 
direction) and the total back-to-back frames of all ports in the selected 
direction for each frame length. 

Multi (Unidirectional) Shows the sum of the back-to-back frames of each input port and the 
total back-to-back frames of all input ports for each frame length. 

Multi (Bidirectional) Shows the sum of the back-to-back frames of each input port, the sum 
of the back-to-back frames of each output port, and the total 
back-to-back frames of all input and output ports for each frame length.

Multi (Auto Reverse) Shows the sum of back-to-back frames of each input or output port 
(only in the selected direction) and the total back-to-back frames of all 
input or output ports (only in the selected direction) for each frame 
length. 

* Unit number x (where x is 1 or 2) and port number y (where y is a number 
between 01 and 13) are displayed as UxPy. 

* Input port: Input-to-output direction.  Output port: Output-to-input direction. 
 
• The unit and direction can be changed regardless of whether the measurement is in 

progress.  The changing of the unit and direction does not affect the measurement 
operation. 

 
• The measured results of multiple ports are displayed in the order specified in the Port 

Pair settings. 
 
 
 

Explanation 
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6.6 Log View 
 
 

Click the Log tab in the Measurement/Result View.  The log is displayed. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
• The Log View can display up to 500 events. 
• The past log is cleared when the measurement is started. 
• The log can be saved to a file.  For details, see section 6.7. 
• The table below shows the contents shown in the log. 

Title Displayed Parameter Displayed Information 

Start Time 
Shows the year, month, day, hour, minute, and second of the 
start time. 

Test Shows the test item. 
Address Auto Learn, Learning Frame, Throughput, Latency, 
Frame Loss Rate, or Back To Back. 

Frame Length (bytes)*1 Shows the frame length of the test data. 

Rate (%)*1 
Shows the test data rate with five digits to the right of the 
decimal point. 

Burst*1 Number of burst frames for the back-to-back measurement. 
Trial*1 Current trial count. 

<INDEX> 

Test Result Judgement result (pass or fail) at the current test phase. 
UNIT Unit number 
PORT Port number 
SPEED Shows the link speed at the start of the measurement. 
DUPLEX Shows the DUPLEX at the start of the measurement. 
IFG(bit) Transmission IFG of the test data. 
Tx. Frame Number of transmission frames of each port. 
Rx. Frame Number of received frames of each port. 
Rx. Byte Number of received bytes of each port. 
Collision Number of collision detections of each port. 
Pause Frame Number of received Pause frames of each port. 
CRC Error Number of received CRC error frames of each port. 
Alignment Number of received alignment error frames of each port. 
Over Size Number of received oversize error frames of each port. 
Under Size Number of received undersize error frames of each port. 
Symbol Error Number of received symbol error frames of each port. 
Link Down Number of link down occurrences of each port 
LF Detect Number of LF detections of each port. 
RF Detect Number of RF detections of each port. 

<UNITx-PORTxx> 

Error Shows the error information of each port. 

Procedure 

Explanation 
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6.7 Saving Measured Results and Log 
 
This section describes the details of saving the measured results and the log shown on 
the Measurement/Result View. 
 

Saving the Result File 
 
 

1. Click the measurement item tab containing the measured results you want to save.  
The Measurement/Result View of the clicked tab is shown. 

2. From the File menu, choose Save Result File.  The Save As dialog box opens. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
3. Enter the save destination and the file name. 
4. Click Save.  The result of the test shown in the Measurement/Result View is saved. 
 
 
 
 
 
 
 
 
 
 
 
 
5. To save other measured results, repeat steps 1 to 4. 
 

 
 
• The measured results of one test item are saved to the result file.  To save the 

measured results of multiple test items, save the result file for each test item. 
• The result file is in CSV format.  If the measurement is in progress, the most recent 

data is saved. 
• If the log is shown in the Measurement/Result View, the result file cannot be saved. 
• All measured results are saved to the result file regardless of the unit and direction 

settings in the Measurement/Result View. 
 

Procedure 

Explanatio
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Saving the Log File 
 
 

1. From the File menu, choose Save Log File.  The Save As dialog box opens. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
2. Enter the save destination and the file name. 
3. Click Save.  The log file is saved. 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
• The log file is in text format.  If the measurement is in progress, the most recent data 

is saved. 
 
• The log file can be saved even when a view other than the log is shown in the 

Measurement/Result View. 
 
• The maximum number of events that can be saved to the log file is 10000. 

 
 
 
 
 
 
 
 
 
 
 

Procedure 

Explanatio
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6.8 Graph View 
 

Showing the Graph View 
 

 
1. Click the measurement item tab containing the measured results you want to graph.  

The Measurement/Result View of the clicked tab is shown. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
2. From the View menu, choose Graph.  The graph of the measured results shown in 

the Measurement/Result View is shown in the Graph View. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Note 

 You can also click the Graph icon to show the Graph View. 
 
3. To show the graph of other measured results, repeat steps 1 and 2. 
4. If you carry out the procedure to show a graph when a graph is already shown, a 

dialog box opens for you to confirm the refreshing of the Graph View.  To refresh, 
click Yes.  To cancel, click No. 

 
 
 
 

Procedure 
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5. If move the cursor on a graph type in the Graph View, the corresponding graph is 
highlighted. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

• The Graph View can be shown when the Measurement/Result View is shown. 
 
• The Graph View can be shown regardless of whether the measurement is in 

progress.  However, it cannot be shown if there are no measured results. 
 
• If the measurement is in progress, the measured result at the time you carried out the 

procedure to show the graph is shown on the graph.  The Graph View is not 
refreshed even when the measurement proceeds.  To show the most recent graph, 
carry out the procedure to show the graph again. 

 
• The contents shown in the Graph View vary depending on the test item as follows: 

Test item Displayed Unit X-Axis Y-Axis Graph Type 
% Frame length (bytes) Throughput (%) Logical values and 

measured values 
frame/s Frame length (bytes) Total (frames/s) Logical values and 

measured values 

Throughput 

bit/s Frame length (bytes) Total (bits/s) Logical values and 
measured values 

Cut through Latency 
Store & Forward

Frame length (bytes) Average (µs) For each test rate 

Frame loss rate - Test rate (%) Average (%) For each frame length 
Back-to-back - Frame length (bytes) Total (frames) Measured values 

* If the X-axis is frame length, the values are shown in the order of the frame lengths 
registered in Test Configuration. 

 
• The content shown in each axis varies depending on the test item as follows: 

Test Item Displayed Unit X-Axis Y-Axis 
% Throughput (%) 
frame/s Throughput (frames/s) 

Throughput 

bit/s 

Test frame length (bytes) 

Throughput (bits/s) 
Cut through Latency CT (µs) Latency 
Store & Forward

Test frame length (bytes) 
Latency S&F (µs) 

Frame loss rate - Test rate (%) Loss rate (%) 
Back-to-back - Test frame length (bytes) Number of burst frames (frames) 

 
 

Explanation 
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Point Label Display 
 

 
1. Click the Point Label icon on the toolbar in the Graph View.  Numeric data is 

displayed at each point on the graph. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
2. Click the Point Label icon again to clear the numeric data. 

 
 

 
You can show or hide the toolbar in the Graph View by choosing Toolbar from the Tools 
menu of the Graph View.  When enabled, a check mark appears by Toolbar. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Procedure 

Explanation 
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Data Editor Display 
 

 
1. Click the Data Editor icon on the toolbar in the Graph View.  The data at each point 

is displayed below the graph. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
2. Click the Data Editor icon again to clear the data display. 
 
 

 
 

• You can show or hide the toolbar in the Graph View by choosing Toolbar from the 
Tools menu of the Graph View.  When enabled, a check mark appears by Toolbar. 

 
• You can also select Data Editor from the Tools menu to show the data display. 
 
• You cannot change the data. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Procedure 

Explanation 
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Zoom Display 
 

 
1. In the Graph View, click the Zoom icon in the toolbar and drag the area to be 

expanded.  The dragged area is shown expanded. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
2. Click the Zoom icon on the toolbar when the display is expanded to return to the 

normal graph display. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

• You can show or hide the tool bar in the Graph View by choosing Toolbar from the 
Tools menu of the Graph View.  When enabled, a check mark appears by Toolbar. 

 
• If the dragged area contains only one data point, only the data point is expanded. 
 
 
 
 

Procedure 

Explanation 
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Saving the Graph 
 

 
1. In the Graph View, choose Save Chart from the File menu.  The Save As dialog box 

opens. 
 
 
 
 
 
 
2. Enter the save destination and the file name. 
3. Click Save.  The graph is saved. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
• You can select the graph save format from CFX, TXT (data only), XML (properties 

only), BMP, or EMF. 
 
• The software application does not have a function to load the saved data.  To view 

the saved data, use an application that supports the respective file format. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Procedure 

Explanation 
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Printing the Graph 
 

 
1. In the Graph View, choose Page Setup from the File menu.  The Page Setup dialog 

box opens. 
 
 
 
 
 
2. Set the orientation and margins, and click OK. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
3. From the File menu, choose Print Preview.  The print preview dialog box opens. 
4. To close the Print Preview dialog box, click Close. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
5. From the File menu, choose Print.  The Print dialog box opens. 
6. To print, click OK.  To cancel, click Cancel. 
 
Note 

 You can also open the Print dialog box by clicking the Print icon. 
 

Procedure 
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7.1 Messages and Corrective Actions 
 

Error Messages 
There are cases in which error messages are displayed on the screen while using the 
RFC2544 TestApplicationE.  This section describes the meanings of the messages and 
their corrective actions.  If the corrective action requires servicing, contact your nearest 
YOKOGAWA dealer for repairs. 

 
System Control Error Messages 

Code Message Corrective Action Ref. 
Section 

11013 Connection failed Failed to log in.  Check the connection using Ping. 4.2 
11018 User name not entered. Specify the login user name correctly. 4.2 
11019 PORT reservation failed. Another user may have reserved the port at the same 

time.  Try to reserve the port again. 
4.2, 4.3 

11020 Port to reserve not selected. Select the port to be reserved. 4.3 
11022 Failed to release PORT. Communication error occurred.  Check the LAN 

cables connected to the PC and AE5511.  Then, 
restart the PC and the AE5511. 

4.1 
3.6*1,  
3.12*1 

11023 LOGOUT failed. Communication error occurred.  Check the LAN 
cables connected to the PC and AE5511.  Then, 
restart the PC and the AE5511. 

4.1 
3.6*1,  
3.12*1 

11036 TELNET connection failed. Communication error occurred.  Check the LAN 
cables connected to the PC and AE5511.  Then, 
restart the PC and the AE5511. 

4.1 
3.6*1,  
3.12*1 

11037 Time out Communication error occurred.  Check the LAN 
cables connected to the PC and AE5511.  Then, 
restart the PC and the AE5511.  If you are using a 
notebook PC, check that the PC is not in standby or 
sleep mode. 

4.1 
3.6*1,  
3.12*1 

11038 FTP connection failed. Communication error occurred.  Check the following 
items and restart the PC and the AE5511. 
• Check the LAN cables connected to the PC and 

AE5511. 
• If the firewall function is enabled on the PC, specify 

FTP passive in the login settings. 

4.1, 4.2 
3.6*1,  
3.12*1 

11039 Unauthorized password. Specify the password correctly. 4.2 

11040 User already logged in. The same login name is used.  Log in again using a 
different login name. 

4.2 

11041 Exceeded maximum number of logins. The maximum number of users (eight) are already 
logged in.  Log in after another user logs out. 

4.2 

11042 Shutting down The AE5511 is shutting down.  To continue operation, 
start the AE5511. 

3.6*1 

11043 Unknown Error Restart the PC and the AE5511. 4.1 
3.6*1 

11044 Disconnected Communication error occurred.  Check the following 
items and restart the PC and the AE5511. 
• Check the LAN cables connected to the PC and 

AE5511. 
• Check the specifications of your PC. 

3.2, 4.1 
4.2 
3.6*1,  
3.12*1 
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Code Message Corrective Action Ref. 

Section 
11045 Disconnected Communication error occurred.  Check the following 

items and restart the PC and the AE5511. 
• Check the LAN cables connected to the PC and 

AE5511. 
• Check the specifications of your PC. 
• If the firewall function is enabled on the PC, specify 

FTP passive in the login settings. 

3.2, 4.1 
4.2 
3.6*1,  
3.12*1 

11046 Application will be shut down due to forced 
logout. 

A user logged in using TTPControl WindowE with 
administrator privileges logged you out, or the AE5511 
was shut down.  Measured data and setup may be 
lost. 

4.2 

11047 Fan error occurred. The fan on the AE5511 is not running normally.  Shut 
down the AE5511, and check that foreign objects are 
not present in the fan vent port. 

1.2*1,  
9.6*1 

11048 XENPAK Error The XENPAK may have malfunctioned.  Replace the 
XENPAK.  However, an XENPAK error may be 
detected when the optical input transits from ON to 
OFF or OFF to ON.  In this case, the XENPAK does 
not need to be replaced. 

- 

11049 Failed to reconnect. Communication error occurred.  Check the LAN 
cables connected to the PC and AE5511.  Then, 
restart the PC and the AE5511. 

4.1 
3.6*1,  
3.12*1 

11050 Cannot login during autotesting. Another user may have reserved the port at the same 
time with the auto test.  Try to reserve the port again. 

4.2, 4.3 

11051 Input may not begin with "-". A hyphen cannot be used for the first letter of an 
access name or user name.  Enter a correct name. 

4.2 

11052 Can not carry out measurement and setup 
because the AE5511 firmware is of an old 
version.  \nLog in to the AE5511 as an 
ADMIN User with the 
TTProControlWindowE software.  
Upgrade the AE5511 firmware after log-in. 

The firmware version of the AE5511 is an old version 
that is incompatible with the RFC2544.  Update the 
AE5511 firmware. 

3.7*1 

11053 Can not carry out measurement and setup 
because the RFC2544 option has not been 
added to the AE5511 firmware.  \nLog in 
to AE5511 as an ADMIN User with the 
TTProControlWindowE software.  Add the 
RFC2544 option to the AE5511 firmware 
after log-in. 

The RFC2544 option is not installed in the AE5511.  
Install the option. 

3.3 
9.5*1 

11056 Invalid address. The login address to the AE5511 cannot be set to 
0.0.0.0 or multicast address.  Enter a correct address. 

4.2 

11057 No space available on hard disk. Not enough free space in the user area on the HDD.  
Consolidate the files of users running auto tests. 

*2 

11059 Response Failed An error occurred on the application.  Restart the PC 
and the AE5511. 

4.1, 4.2 
3.6*1 

13052 Could not open file. Check whether the access to the save destination 
drive is prohibited.  For an external drive, check the 
cabling. 

- 

13070 Log file read error. The log file could not be loaded.  Log out, and restart 
the PC. 

4.2 

13071 Cannot close Measurement/Results screen 
during measurement. 

The Result View cannot be closed while the 
measurement is in progress. 

6.1 



7.1  Messages and Correction Actions 

IM 731070-01E  7-3 

77

Troubleshooting 

 
Code Message Corrective Action Ref. 

Section 
16530 Can not paste because the copy buffer is 

empty. 
The copy source of the port setup is not designated.  
Copy before paste. 

5.9 

17041 Register the same number of inputs and 
outputs in the port pair settings. 

When the traffic map of the port pair is one-to-one, the 
number of registered input ports must match that of the 
output ports.  Match the number of input ports to that 
of the output ports. 

5.2 

17056 Register input ports or output ports in the 
port pair settings. 

Input port or output port is not registered in the port pair 
setup.  Enter it correctly. 

5.2 

17057 This file cannot be loaded. The file that you tried to load is not supported.  Check 
the file. 

5.8 

17055 Could not read from File. An error was found in the file.  Check whether the file 
on the drive is corrupt. 

5.8 

17019 Link Layer setting error. An error occurred on the application.  Restart the PC 
and the AE5511. 

4.1 
3.6*1 

17020 Port Pair setting error. An error occurred on the application.  Restart the PC 
and the AE5511. 

4.1 
3.6*1 

17021 Test Configuration setting error. An error occurred on the application.  Restart the PC 
and the AE5511. 

4.1 
3.6*1 

17022 Throughput setting error. An error occurred on the application.  Restart the PC 
and the AE5511. 

4.1 
3.6*1 

17023 Latency setting error. An error occurred on the application.  Restart the PC 
and the AE5511. 

4.1 
3.6*1 

17024 Frame Loss Rate setting error. An error occurred on the application.  Restart the PC 
and the AE5511. 

4.1 
3.6*1 

17025 Back To Back setting error. An error occurred on the application.  Restart the PC 
and the AE5511. 

4.1 
3.6*1 

17026 DUT Information setting error. An error occurred in the communication or on the 
application.  Check the LAN cables connected to the 
PC and AE5511.  Then, restart the PC and the 
AE5511. 

4.1 
3.6*1,  
3.12*1 

17027 Setting registration error. An error occurred on the application.  Restart the PC 
and the AE5511. 

4.1 
3.6*1 

*1 Reference section in the AE5511 TrafficTesterPro User’s Manual (IM417322900-01E). 
*2 Reference section in the AE5511 TrafficTesterPro Remote Command Manual (IM417322900-17E). 
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